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Introduction
DEC is committed to making sure that the PDFs on our public website are easy to use,
accessible to all users, and up-to-date. Standards that spell out these requirements are
available on SharePoint. Users outside of DEC should contact their DEC contact for this
information. It is not relevant to PDF accessibility.

Spring 2020 note: We are currently auditing all of the PDFs on the public website, an
effort that will continue through most of 2020. Please consult with your web content
coordinator or a member of the web team if you have any questions about the
appropriateness of a PDF that you are creating.
Equal access to information isn’t just the law, it’s the right thing to do. Ensuring this equal
access is called accessibility and it’s an important element of getting documents ready to share
online – either on In-Site or on DEC’s public website. We also need to be mindful that up to 2/3
of the visitors to our public website are visiting on mobile devises that may not display PDFs
very easily. Why post content on the website that isn’t going to be read? Follow these directions
to create documents that are usable and accessible to maximize the value to your audience.

Enhancing Usability
Improving the end-user experience of all of the DEC website – and especially PDFs - has a lot
of value. It makes the important information you are sharing easier to read, and it assists people
using adaptive technology to use your document as well. Enhanced usability is important for
documents that start as Word documents as well as those that begin as scanned documents
and have been through the conversion process using Optical Character Recognition (OCR).

Accessibility and Tagging
Tagging means giving specific background instructions to an assistive technology device so a
computer can understand how to read through the document in order. The instructions here and
on the accessibility document focus on how to add tags to every element of your document. An
untagged element will create issues with an accessibility check and, more importantly, will make
it very difficult for an assistive technology device to effectively present your information. Imagine
trying to understand a topic when you only read every other page of a book. Or imagine how
difficult it would be to understand a topic when all of the tables, charts, figures, images,

headlines, columns, and more are just a jumble of out-of-order words, grayed-out images, and
so on. Properly tagging a document helps an assistive device present the information in the
same way as it was designed and intended to be read.
Reminder: There is a complete document outlining the specifics of web accessibility available
on SharePoint.
The topic of web accessibility is large and complex. There are many online resources available
for those with an interest in learning more. Web accessibility training is available by request for
individuals or small workgroups. Larger group trainings are offered periodically as well. Reach
out to webpost@dec.ny.gov to arrange training or request help.
While the overall topic is complex, putting some effort in to your documents before you make a
PDF simplifies things and makes the process smoother and more efficient.

Using Styles in Word 2016
The earlier in the document production process that you start thinking about document
accessibility, the better. Using the tools available to you in Word 2016 will be very helpful.
Basics like using the spelling and grammar checking tools are a given. But using other tools like
heading styles, alternative text, links, columns, and tables according to the following directions
will save time and effort when getting a document ready to share with others.

Adding Structure with Styles and Formatting
As you create new documents to share, add the necessary structure by using styles and
formatting properly, before you convert your document to PDF.
Adding structure to your Word document from the beginning will help ensure that the PDF
document will be properly tagged, since the structure is retained when it is converted to PDF.
Tagging a PDF entirely in Adobe Acrobat is more difficult than converting a properly structured
Word document into a tagged PDF. Most documents converted from a properly formatted Word
document will typically require minimal touch up in order to be fully accessible.

Setting Your Acrobat Preferences
Before you begin working in Word, it's important to know whether you have Adobe Acrobat (not
just the reader) installed on your computer. You should see a tab for Acrobat on the Word 2016
ribbon. If you don’t see Acrobat on your Word 2016 ribbon, speak with your IRC. It is required
for editing PDFs and creating accessible PDFs.
To check your conversion settings in Word:
1. click on Acrobat from the ribbon at the top;
2. select Preferences and a window will pop up. Adjust your settings to match the following
image:

3. Next click the Word tab and set as shown:

4. Make sure all of your selections match the boxes checked in both images above.

Getting Started with Styles
Once your settings have been adjusted, and you're ready to create your document, click
on Home from the ribbon at the top and open the Styles side bar by selecting the expand option
from Styles on the ribbon:

If you prefer not to have the sidebar open as you're working on your document, you can access
the styles and formatting from the ribbon, which will provide a scroll down menu for you to select
from. It's important to note that you're not limited to the font type and size already set on any
given style; they can easily be changed to suit your needs. From the side bar select a particular
element you'd like to change. Once selected, click the Manage Styles button (Button with A and
a green checkmark) at the bottom:

In the resulting window, select Modify and make any changes you would like:

Any text in the document with that particular style will use the format you've defined. If you use
customized headings (headings where you changed the font, weight, size, etc.), they should be
identified in your document instead of the standard headings – the ones that come with Word.
(When you hear “don’t use bigger bolder font” this is what we mean!). Identifying your
customized headings is done through the bookmarks tab, also found under
the Preferences option from the Acrobat ribbon option. Once the bookmarks tab is open, select
those that apply.

Styles for Heading Formats
Headings are used to separate chunks of information in your document and when used
effectively help arrange the information in clear and logical manner for the reader. As such, it's
important to select the appropriate headings as the document is being created. Headings should
start with Heading 1 or H1 – this is the largest, boldest heading. Headings descend in order,
Heading 2, Heading 3, and so on. Most well-designed documents only use three, or
occasionally four, heading levels. Each heading level has a specified font, size, weight, and
style. They are generally designed to work together in a document.
Applying the heading style can be done to a finished document or can be applied as you're
typing. To add a heading style to text that is already typed, you would highlight the text then
select the appropriate heading style from the sidebar or from the ribbon. Alternatively, a style
heading can be applied as you're typing it, by placing the cursor at the spot where the heading
will be and selecting the appropriate style first.
Please note: When your document is converted to PDF, the headings will automatically appear
as bookmarks in the PDF version. If you don’t use headings in Word, you will have to manually
create the bookmarks in Acrobat. This is a LOT more work!

Structuring Lists
Lists are a great way to present your information in a clear and concise fashion. They fall into
two basic categories: ordered and unordered. Ordered lists are often referred to as numbered
lists and are used when the sequence of your entries is important. Unordered lists often use
bullet points to display or highlight key points in your document.
Like adding style to your headings, lists can have style added after you've typed out your
information or before you start. Before you start to type your list, choose from the side bar the
type of list you want to create, click on the style and begin typing. If you already have your
information in your document, you would highlight the list and then add the appropriate list style.
Alternatively, lists can be created with the ribbon at the top, under Home >> Paragraph >> [List
Type]:

Creating and Formatting Tables
To create a table in Word, select Insert >>Tables >> Table from the ribbon at the top:

From the Insert Table dialog box, set up the number of columns and rows you need. If you need
to add more columns and rows, adjust the alignment, center the text within a cell or make other
additional changes select Layout on the ribbon, and then choose the appropriate option for the
changes you need to make:

If you create a table that continues on to the next page, the header should be repeated. Make
sure you define the header row on any page that requires a header. This is a common issue
that appears in an accessibility check and paying attention to it in Word makes the accessibility
and PDF conversion process much easier.
Please note: Once your Word document has been converted to PDF you will most likely need
to do additional work in Acrobat to make your table(s) accessible. (See Accessibility
instructions.) Because tables pose additional challenges to accessibility, they should only be
used for tabular data and not in place of columns, text boxes, or other layout elements.

Creating Columns
Columns should be created using Word's column tool and not with the tab key. From the ribbon
at the top, select Page Layout >> Page Setup >> Columns:

The dialog box that appears will allow you to select the number of columns you will need. If you
only need a portion of your document to appear in columns, you would highlight the appropriate
text and repeat the steps above.

Adding Hyperlinks
To create a link in Word, highlight the text that will become the link and from the ribbon
select Insert >> Links >> Hyperlink:

Type (or copy and paste) the URL into the address field once the Insert Hyperlink dialog box
appears. Your link(s) will be captured and properly tagged when the document is converted to
PDF.
Remember: If linking to something on the DEC website, always use https:// - you may need to
update the link you have copied.

Alternative Text for Images
Having alternative text (alt text) in images is very important and often overlooked on many
websites. Those who use assistive devices such as screen readers rely on alt text to provide
meaning to the images in your documents. Without the alt text, a screen reader would most
likely miss the image entirely or possibly pick up some meaningless text that may confuse the
user.
To add alt text to an image in a Word document:
1. right-click on the image (note: before adding an image, the file size should be reduced
according to web standards);
2. select the Edit Alt Text option; and
3. type the alternative text in the box or choose the recommended alt text if appropriate.
Mark as decorative for logos or other non-informational images. Make sure to confirm
that any suggested alt text actually describes the content of the image and is relevant
and appropriate. Using alt text of “cell phone screen” is much less helpful than alt text of
“cell phone screen with mapping app displayed.”

Additional information on writing alternative text is provided in the website standard.

Convert to PDF
As previously mentioned, an add-in for Microsoft Office is installed by default when Adobe
Acrobat is installed on your computer. To convert your structured Word document to a tagged
PDF, select Acrobat from the ribbon and then Create PDF:

Please note: For tagging purposes, using the "print function" to create a PDF or using “save as
PDF” should be avoided. Always use “Create PDF” to make a tagged PDF. Anything other than
“Create PDF” will provide you with a document that requires more work to make it accessible.

Getting Your PDF Ready for Distribution
While there are some automated tools you can use, giving your document a final check is
ultimately a manual process. First, run the Acrobat Accessibility checker and make any
necessary fixes. Follow the directions for reducing file sizes. Work through the Usability and
Accessibility checklist. Double check the file properties – remember the author of every
document is DEC!
Get started by checking a few things in Adobe Acrobat:
•

Document Language: In some cases, it's possible that the document language didn't
carry over into the PDF version. To set the language for the entire document, select File
>> Properties and click on the Advanced tab. From the Language drop down of the
Reading Options section choose the appropriate language for the document.

•

Tab Order: You should make sure that the tab order is consistent with the structure
order. Even though the tags have been inherited from the Word document,
the Accessibility Checker may indicate that tab order is not consistent with structure
order. To fix this, from the main menu select View >> Navigation Panels >> Pages. Then
from the main menu again select Edit >> Select All. From the Options button on the
pages panel select Page Properties. In the Tab Order Panel, check Use Document
Structure.

•

Table Elements and Summary: Table headers will need to be properly defined once a
document has been converted from Word to PDF. The TouchUp Reading Order tool can
be used to add your table headings to the PDF document. As needed, row span and col
span attributes should be set at this stage as well. Once the document is converted to
PDF, you should add an appropriate table summary. To add a table summary, go
to Tools >> Advanced Editing >> TouchUp Reading Order. Close the dialog box that
opens and using your mouse draw (hold left click and drag) a box around the entire
table, right click and add the summary into the dialog box that opens.

Selecting Document Properties
From the File menu, choose Properties to control how your document is viewed by end users.
On the Description tab, the Title of your document should never be the file name. It should
always be the actual title (the words on the title page) of the document.
The Author of your document should always be NYSDEC. It is not necessary to include the
name of the division that created the document and there should never be an individual staff
member’s name in the author field.
The Subject line should include a plain language description of the purpose of the document.
Do not repeat the document title. Note that both the title and the subject are displayed in search
results, so they must be clear and grammatically correct and different from each other.
Make sure to select appropriate and useful Keywords to make your document easier to search
for on the Internet.
On the Initial View tab, for the Navigation tab, choose Bookmarks Panel and Page (if the
document is long enough to have bookmarks); under Window Options, make sure you have
chosen Show Document Title (instead of Show File Name).
Leave the Security tab set to “No Security”.

Making Your Document Easier to View
Remember that usability is ultimately about making the user experience easier and more
efficient.
What do you want your end user to see when they open your document? A best practice is to
show the first page while the rest of the document downloads.
While in your PDF, choose Edit and then Preferences.
Choose Document and under Save Settings make sure “Save As Optimizes for Fast Web
Viewing” is checked. (Remember to Save As – using Save makes your file size larger.)

Another way to make your document easier to view is to make sure you allow the end user to
view it using fonts on their computer.
From the Preferences menu (In Acrobat, Edit, then Preferences) choose Page Display from the
list on the left. Under Rendering, uncheck the box for Use Local Fonts, and then make sure that
the document is still completely legible. Once you verify that local fonts are not necessary to
view the content, you can recheck this box.

How to Make Live URLs in PDF
Please note: If you are linking a PDF back to a DEC web page, be aware that web addresses
will be changing when we transition to new web software at a future date. You can either keep
track of the links you will need to update in your PDFs, or you can link to the DEC home page
(that address will not change) and suggest search terms to use to get to the information you
want to share. The use of bit.ly links (or other similar link-shortening options) is not encouraged.
If you have more than a small number of links in a PDF you may be better off converting the
page to HTML instead. Discuss options with your Web Team coordinator.
If you have determined you do need to add a link to a PDF, choose Edit PDF from the Acrobat
tools. Select Link and then Add/Edit Web or Document Link. Next, drag a box to where you want
to add the hyperlink. At this time, you must save the file to save and display your added link.

Numbering Pages
Some PDFs are a compilation of other documents. Some have “frontmatter” – a table of
contents, an introduction or executive summary, or other pages that come before the content.
Others have “backmatter”- appendices, indexes, bibliographies, end notes, and other similar
items that come after the main content. Numbering the pages in a PDF sequentially is very

important. Depending on the audience for the document, you may need to use one type of
numbering for frontmatter or backmatter and a different type for the main content. Fortunately,
Acrobat has an easy-to-use Page Numbering function. From the Acrobat Tools, choose
Organize pages. Thumbnails of all your pages will appear. Select the pages you want to number
or change the numbering on. Right click on the first thumbnail you’ve selected and choose Page
Labels.

You can work on All pages, just the pages you selected, or a defined series of pages. In the
Numbering section, use the dropdown menu to choose the number style (Roman numerals,
upper- or lowercase letters, ordinal numbers, etc.). You can also choose where to start your
numbering (page 1, or a later page); or you can use consistent numbering throughout a
combined document by choosing “Extend numbering used in preceding section.” Select OK
when you have completed your selections.

Using PDF Forms
Always remember that any form you put online must provide the same information as any
printed form for that purpose that exists – they must be equally acceptable. While simply turning
a print-based form into a PDF is one option, it is often not the most usable or accessible choice.
Creating a form-fill (fillable) PDF is more user-friendly and, if done properly, is more accessible.
Web team staff can help you if you are not familiar with how to create fillable forms in PDF or
how to make them accessible. Reach out to webpost@dec.ny.gov.

Creating and Editing PDFs from Scanned Documents
While it is always best to start the creation of a PDF in MS Word, some documents come to
DEC as scanned PDFs or PDFs with some scanned elements included. Fortunately, Acrobat
can convert scanned PDFs to a machine-readable format using a process called optical
character recognition (OCR). All scanned PDFs must be converted in order to be made
accessible.
Scanned PDFs can often be obvious to the viewer – the pages may not be straight, there may
be extraneous markings in the margins, or they may even look a bit fuzzy or out of focus. For
files where it is not obvious whether it is scanned, there are two tricks that can help.

1. Look at the file size of the document. Scanned files are images and are often quite large.
A large file size is a potential clue that your document may be a scanned image and
needs to be converted.
2. Try to highlight some of the text in your file. If you can highlight a single word or a few
words, your file is not a scan or has likely already been converted. If, when you attempt
to highlight something, you get a large box that covers most or all of a page, your file is a
scanned image that still needs to be converted.
Once you have determined you have a file that needs to be converted, open the file using
Acrobat DC Pro. (Open Acrobat, then choose your file.) You need to have PDF editing software
in order to convert a file. If you do not have PDF editing software, others on your team may
have it. If no one on your team has the software you may reach out to webpost@dec.ny.gov for
assistance converting files and requesting PDF editing software.

How to Convert a Scanned PDF using OCR
With your document open in Acrobat, select More Tools from the menu on the right-hand side.
Then choose Scan & OCR.

Now select Recognize Text and choose “In This File” from the dropdown menu.

Choose Recognize Text again by clicking the blue button.
The process may take some time to convert the document, depending on its length and
complexity.

Proofreading Your Document
Once you have completed the OCR process it is critically important to proofread your
converted document. OCR is not perfect and can introduce errors through the conversion
process. Carefully compare the document before OCR and the document after OCR. Make sure
everything is correct and readable. Fix any errors that are introduced.
Acrobat has a Compare Files feature (View > Compare Files) that may be useful in some
situations. You can also copy text into Word and manually compare files. A scanned PDF is
viewed by a computer as an image – so any automated comparison will not work to compare an

OCR’d PDF against a scanned source document. You will need to manually review every
character, line, punctuation mark, caption, image, etc.
Please note: As noted above, it is a time consuming and somewhat onerous process to proof
an OCR’d PDF against the source document. It is likely more efficient to reach out to the source
of the document and request an electronic file. Realistically, no one is typing a document on a
typewriter anymore – an electronic copy exists somewhere! All vendors to DEC are REQUIRED
to provide accessible electronic files of anything they submit. Don’t be shy about holding your
vendors to this standard – part of their negotiated fees includes them meeting our standards.
Reminder: It is NOT necessary to scan a document simply to show a signature or initials. The
proper procedure is to use the electronic copy of the document (properly tagged) and present it
without the signature in place.

Reducing File Sizes of PDFs
Please note: It is always important to keep PDF file sizes as small as possible. Because so
many people access our website from mobile devices, optimizing for small file size is more
important than ever.
Following the instructions below, you will be able to reduce the file size of most PDFs. (Note:
these instructions are based on Adobe Acrobat DC Pro, and you might encounter different
settings in other versions.)
Please save an extra copy of the original PDF before following the instructions below. In
some cases, these instructions may produce unacceptable results that cannot be
undone, so you should always have a good original copy of the PDF to go back to.
•

Begin with a PDF that meets the PDF document standard, as described above, and
open it in Adobe Acrobat.

•

The fastest way to reduce the size of file:
o

File > Save As Other > Reduced Size PDF...

o

Make compatible with: Retain Existing > OK and Save the File

o

Remember you must use Save As Other – if you just choose Save the file size
will increase each time you hit Save.

•

If this did not reduce the file size enough, or if you want to optimize the file, continue with
the following directions.
Please note: If your PDF is a scanned document, OCR it before you attempt to optimize
the document (directions for OCRing above)

•

Images should only be used in PDFs when needed to convey important information.
Remove any decorative images and unnecessary logos.

•

o

Tools > Edit PDF

o

Select each unneeded image and delete – this might be logos, decorative items
in a header or footer, or other design elements that do not provide information.

o

Repeat Step 2

Using the Optimized PDF function:

o

File > Save as Other > Optimized PDF

1. Images – make sure to select Retain Existing in the “make compatible with” field;
the rest of the options should remain as is in the default.
2.

Fonts - select any common or unnecessary fonts to unembed (the document
should use as few fonts as possible)

3. Transparency – the default is high resolution. If you have a document with many
images and the primary purpose is to convey information online, choosing a
lower resolution will effectively reduce your file size and make your document
faster to load. It will also take less data/memory for any mobile users accessing
your document.

4. Discard Objects - Select all boxed except "Discard document tags" and "Discard
bookmarks."
Note: If the PDF contains a fillable form, DO NOT select the first two boxes
relating to forms

5. Discard User Data - Check all the boxes except "Discard Document Information
and Metadata"

6. Clean Up - Next to "Object Compression Options:" choose "Compress entire file".
Check all of the boxes.

*** A note about "Optimize the PDF for fast web view": This function causes the PDF to
open faster, but it does so by adding data which results in a larger file size. If the file size is

too large, unchecking this box will reduce it a little bit. However, when possible, leave it
checked so that the file opens more quickly for our users.
•
•
•
•

These settings should come up again the next time you open Acrobat, but they can be
saved for reuse by choosing "Custom" from the "Settings:" line in the upper-left corner of
the dialog box.
Click "OK" to save the optimized file.
Use "Save As" rather than "Save" to save the file.
Always check the file to make sure that the optimization has produced an
acceptable PDF before loading into RedDot asset manager.

Splitting a PDF
1. Tool > Organize pages > Split
2. You have the option on how to split the document
1. By the number of pages
2. By the File Size
3. By Top Level Bookmarks
3. Select how you would like this done and select "Split"
1. Adobe will automatically add "Part#" to the end of each file name
2. Remember to edit your file names to fewer than 20 characters, all lowercase, no
spaces before adding files to the Asset Manager in RedDot.

Checklist of PDF Requirements
Before submitting your PDF for posting on the website, open the document in Adobe Acrobat
and choose Edit > Preferences... > Page Display, and then deselect "Use Local Fonts". This will
allow problems with font embedding to show up. You can recheck that box once your review of
the document is complete. Check that each of the following criteria are met.
Document meets the criteria for posting on the website as a PDF (use the PDF standard
here!)
PDF has the correct page breaks, columns, fonts, colors, and general layout and
appearance
PDF is not scanned; or OCR has been used to turn the image to text
PDF is tagged
PDF passes accessibility check (Tools > Protect & Standardize > Accessibility)
PDF opens with the title showing and at correct page number and magnification
PDF has title, author (ALWAYS DEC!), subject, and keywords entered, and no security
restrictions set
PDF has the language set to English
PDF system page numbers match document page numbers
Web addresses are turned into links, and unlinked text does not appear blue or underlined
to appear like a link
Bookmarks are added and set to open automatically (if document is long enough)
Table of Contents is linked (if there is one)
PDF is optimized for fast web view (through "save as")
File name meets the site standard: all lowercase letters and numbers, not exceeding 20
characters, ending with .pdf
File size has been reduced as much as possible, and does not exceed 10 MB

